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SERIAL PORTS

Connect the Finger Sensor to the serial 
port of your PC. If your com put er does 
not have a serial port, see the Frequent-
ly Asked Questions section for further 
instructions. 

Install the Software

Insert the Freeze-Framer CD into your CD-ROM drive. The software 
installer will start automatically.
The installer dialog box ap pears. 
Follow the instructions on the screen. The 
serial/registration number (FF2 followed by 
seven digits) is located on the back of this 
Quick Start Guide.

If you are installing on a computer run-
ning Windows XP, 2000, or NT4, we recommend that you install as a 
user with Administrator privileges. (If you don’t know what that is, 
just continue with the installation.) On Windows XP, 2000, and NT4 
systems, you will be asked to choose the Installation Type. (Windows 
95, 98 and ME users will not be asked.) If you are the sole user of 
your PC or a home user, we recommend the “Shared Application and 
Data” option. If several people share this computer, we recommend 
the “Shared Application Private Data” option. Most users can simply 
click on the “Next” button on all of the rest of the installer screens.

Restart the computer once the in stal la tion is complete. If you attach 
a Palm Pilot or other device to the serial port of your com put er, you 
will need to tem po rari ly disable the com mu ni ca tions software for 
these devices in order for the Freeze-Framer to properly func tion. 
See the Frequently Asked Questions section for further in struc tions.
Once the restart is com plete, double-click on the Freeze-
Framer Icon on the desktop to start the program.

 If you are upgrading from Freeze-Framer 1, your user and session 
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data will automatically be converted and made available with the 
Freeze-Framer 2.0 program.

Look over the Freeze-Fram er’s Main Win dow. You can click on 
the icons here to start us ing any part of the Freeze-Framer.

Click on the Tutorial button to learn about 
the Freeze-Framer. Be sure to review the 
Quick Coherence™ technique section 
before proceeding.

Click on the Heart Rhythm 
Display Button.
  
Collect accurate data

Insert your fi nger in the Finger Sensor. Put the 
fl eshy “fi ngerprint” part of your fi nger against the 
rectangular lens and hold it fi rmly in place with the 
black strap. Your fi nger should be relaxed; it is okay 
to put your hand in your lap.

Click the Start Icon. 

Then click the Pulse Wave Icon.  

Adjust your fi nger until your pulse wave data 
shows distinct, smooth pulse spikes.

View your Heart Rhythm and Coherence Ratios

Click on the View Coherence  Ratios Icon. After 20 seconds has 
elapsed, the Freeze-Framer will begin to com pute your 
“Coherence Score,” and the screen will adjust.

Shift your heart rhythm by prac tic ing Quick Coherence. Notice the 
changes in your Heart Rhythm Graph. The goal is to have 0% low 
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coherence, 0% medium coherence, and 
100% high coherence. Most people start 
out close to 100% low coherence--this is 
normal. With practice, you will shift the 
score towards medium and high coher-
ence. The three coherence score values 
add up to 100%. If you’re not getting any 
medium or high coherence, go to the 
Challenge Level menu and change the setting to “Low”, and if you 
easily get high coherence, change the setting to high or highest.

If you want to turn off the audio feedback, go to the Edit menu, Op-
tions item, click on the Sound tab, and set “Audio Feedback” to off.

Click on the Stop Icon     to end the session.

Review your coherence ratio scores. You can view changes that took 
place during the session by reviewing the Accumulated Coherence 
Score window in the lower left corner of the screen. If you spent 
some time in medium or high coherence, the blue line will show an 
up slope. 

After stopping, the Toolbar changes:

Click on the Save Data Icon.     The Save Data dialog box 
appears. 

If your name is not on the pop up list of User 
Names, click on "New User," enter your user 
name and click on "OK."

The data from your fi rst session is saved. Click on “OK.”
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Other buttons on the Toolbar:

Return to the Home Screen.  

Start a new session.                    

View your progress.                  

Review a previous session.     

Click on context-sensitive 
help icon, then somewhere 
on screen to get more infor-
mation about a specifi c aspect of the program.

Play a Game

Important: It’s best not to attempt to play the games until you have 
practiced the Quick Coherence technique. Practice using the Heart 
Rhythm Display screen fi rst. Once you can successfully reduce the 
low coherence score to about 50% you will be ready to try the Freeze-
Framer games.

Choose a game by clicking on a game button.
  
The starting  screen for the game will appear. Click on the 
Start Icon located in the lower left corner of the screen.  
You will see the “Now accumulating data” box 
appear. The game has started. You are being 
scored on the data being ac cu mu lat ed starting 
the mo ment this box ap pears. Therefore, begin 
to apply the Quick Coherence technique as 
soon as you see this box appear.
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Within 20 seconds after the box dis ap pears, you may begin to see 
some response to your coherent heart rhythm.

Play the game until it ends or until you want to stop. To 
stop the game, click on the Stop Icon on the Icon Bar at 
the lower left corner of the game screen.
  

Click on the Exit button. 

The review screen for your session will 
appear. It presents a summary of the data 
from your ses sion, including your heart 
coherence ratios. The review screen looks 
like the example on the right.

To leave the review screen, click on any Icon. The Save Data dialog 
box will appear. Choose the ap pro pri ate responses. 

Congratulations! You are now using the Freeze-Fram er!

To get the most out of your Freeze-Framer be sure to read the 
online help system.

Go to the Help menu, Help Topics item. If the index is not showing, 

click on  then click on the Contents tab, if necessary.

If you’re upgrading from version 1.x of the Freeze-Framer, see the 
Getting Started, What’s New in Freeze-Framer 2.0 section in the help 
fi le.

Please register your software. 

With your computer connected to the Internet, go to the Help menu, 
Register Freeze-Framer item, which will open a Web browser window 
showing the Freeze-Framer registration form or you can fi ll out and 
mail the enclosed registration card.
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Troubleshooting Guide
If your problem is not addressed in this guide, go to the Freeze-Fram-
er program troubleshooting help section—go to the Help menu, Help

Topic items. Click on  then click on the Contents tab, if 
necessary. Click on the Troubleshooting item in the table of contents.

Installation issues

I put the CD into the computer, and the installer screen doesn’t 
appear. 

Double-click on the “My Computer” icon on the desktop. If the CD-
ROM icon says “Audio CD”, then you’ve inserted the Quiet Joy music 
CD instead of the Freeze-Framer software installation CD. Remove 
the music CD from the CD-ROM drive and insert the Freeze-Framer 
installation CD. The installation program should start automatically. 
If you have the Freeze-Framer software installation CD in the CD-
ROM drive, double-click on the CD-ROM icon in the “My Computer” 
window, then double-click on the Setup.exe icon. This will start the 
installer. 

The installation program won’t accept the registration number. 

The registration number starts with “FF2” followed by seven digits. 
(No letter O’s are in the registration number.) Use the registration 
number from the back cover of the Quick Start Guide, not the regis-
tration number on the fi nger sensor.

How do I know if I have the latest version of the Freeze-Framer 
software? 

When the Freeze-Framer program is running, go to the Help menu, 
click and drag down to the “About Freeze-Framer” item. You’ll see 
the version number on the resultant screen. You can download and 
install the latest version of the program fi les by going to the Help 
menu, Online Support item. (Your computer must be connected to 
the Internet.) 
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How can people with small fi ngers use the fi nger sensor? 

Insert a cotton ball or a small piece of foam between the black fi nger 
sensor strap and the fi nger. You can turn the fi nger sensor around so 
that the cord is pointed toward you, so that the tip of the fi nger more 
easily reaches the sensor window. 

The connector on the Freeze-Framer fi nger sensor doesn’t match 
the serial port connector on my computer. 

Some older PC serial ports (COM ports) have a DB25 connector. In 
this case, you will need a DB25 female -DB9 male adapter, which 
is available from most computer stores for a few dollars. If this is a 
second serial port, you may have to enable it at the BIOS level of 
your computer, otherwise you’ll get a “Pulse sensor not found” mes-
sage when you run the Freeze-Framer program. Follow the instruc-
tions included with your hardware for changing BIOS settings. Your 
computer may not have a serial port. There is an external monitor 
connector on laptops that is the same size as the fi nger sensor con-
nector, but which has 15 instead of 9 pins. 

How can I determine what serial ports are active on my com-
puter? 

To see the status of the serial ports, right-click on My Computer, 
and choose Properties from the menu. Click on the Hardware tab 
of the System Properties window, then the Device Manager button. 
Click on the Ports (COM & LPT) to see what COM ports exist. If a 
small yellow or red graphic is present on a COM port, a problem or 
confl ict may exist that will have to be fi xed before the Freeze-Framer 
program can read data from the fi nger sensor. 

My PC has a mouse connected to the serial port. What can I do? 

You have a number of options. 1.) See if your PC has a small round 
port that you can connect a PS/2 mouse to. Substituting a PS/2 
mouse for the serial mouse would free up the serial port for the fi nger 
sensor. 2.) Consider installing a serial/parallel port card, which would 
give you an additional serial port for the fi nger sensor. 3.) If your PC 
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is running Windows 98 or Windows 2000, you could install a USB 
card, and either get a USB mouse, or a serial-USB adapter for the 
fi nger sensor (see the next question.) 

My PC doesn’t have a serial port. How can I connect the Freeze-
Framer? 

You can use a serial to USB adapter if your computer has USB ports. 
We’ve tested the Belkin USB PDA Adapter, part number F5U109. For 
a list of some U.S. resellers, go to http:/www./shopper.com and enter 
“F5U109” in the search window. Be sure to install the Belkin soft-
ware from the Belkin installation CD before connecting the Belkin 
adapter to the computer. For a directory of U.S. and international 
resellers, go to  http://www.belkin.com and click on the Where to 
Buy link. (No other serial to USB adapters have been found to work.) 
Note: the USB sensor option in the Options panel is for a future USB 
sensor. Always select the "Serial Sensor Port Sensor" radio button, 
when using a serial sensor, regardless of how it is connected to the 
computer.

I’m using a USB-serial adapter to connect the fi nger sensor to 
my PC via a USB hub. I get a “Pulse sensor not found” message. 

If the fi nger sensor is connected to a PC via a serial-USB adapter 
and a USB hub, the USB hub must be powered; otherwise the fi nger 
sensor doesn’t get the power that it needs from the USB port. Try 
plugging the serial-USB adapter directly into the computer. 

Another possibility is that the Belkin adapter was installed with a 
high COM port number on a Windows XP or 2000 computer. To 
check this, go to the My Computer icon. Right-click on it and go 
to Properties. Click on the Hardware tab, then the Device Manager 
button. Scroll down the list to the “Ports (COM & LPT). Double-click 
on the Belkin F5U109 item. Click on the Port Setting tab, then the 
Advanced button. Next to the COM Port Number select the lowest 
available COM port, preferably COM1. Click the OK buttons and 
close the Device Manager window. Run the Freeze-Framer program 
to see if this solved the problem.
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The message “Pulse sensor not found. Please make sure sensor 
is connected to the serial port on your computer.” appears when 
you want to select one of the Training Modes. 

Make sure that the sensor is plugged in to the serial port on the back 
of your computer. Then select Exit from the File menu and restart 
the Freeze-Framer software by double clicking on the Freeze-Framer 
program icon on your desktop. 

If you have two serial ports, one with a serial port mouse and the 
other with the fi nger sensor - shut down and power off the computer. 
Switch the fi nger sensor and mouse connectors on the back of the 
computer. Restart the computer. Run the Freeze-Framer to see if 
the fi nger sensor is found. Another approach would be to install a 
PS/2 mouse in place of the serial mouse, if your computer has a PS/2 
mouse port on the back of the computer. 

If you have software loaded that connects to external devices that 
connect via the serial port—like the Palm Pilot, a Windows CE device 
(see below), another computer (e. g., IntelliSync or LapLink) or de-
vices like a digital camera, you will need to disable the software that 
accesses these devices before starting the Freeze-Framer software. 
Re-enable the software and reconnect the other device when you 
want to use the other device. 

Another way to check to see what programs could be utilizing the 
serial port is to look at the list of programs that automatically start 
when you boot your computer. Click on the “Start” button in the 
lower left corner of your desktop. Move the mouse to “All Programs” 
tab if necessary. Click on the “Advanced” button. Click on the “+” to 
the left of “Programs.” Click on the “StartUp” item in the list. Exam-
ine the list to the right. See if any of the programs listed would utilize 
the serial port. If you no longer use any of these items, drag the icon 
to the desktop to remove it from the list. This way you can put the 
icon back if you need to. Later, you can put it in the Trash after you 
are certain you no longer need it. 
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Another way to test the fi nger sensor is to install the Freeze-Framer 
software and fi nger sensor on another PC. If it works, there’s prob-
ably an issue with your PC’s confi guration. If not, it could be an issue 
with the fi nger sensor (very rare.) 

Call technical support if you still get a “Pulse sensor not found” mes-
sage. 

Installation - Palm Pilot and other device issues 

I have a Palm Pilot that I connect to my serial port. Will there be a 
confl ict with the Freeze-Framer fi nger sensor? 

To use the Freeze-Framer, you fi rst have to quit the Palm Pilot Hot

Sync utility by right-clicking the HotSync icon  in the Win-
dows system tray (lower right corner of the desktop), and choosing 
“Exit.” If this does not work, connect your Palm Pilot to the serial 
port and try again. If your Palm Pilot is not available, you can force 
the HotSync program to quit - hit the control-alt-delete keys, select 
HotSync from the list of tasks, and click on the “End Task” button. In 
a few seconds, you’ll probably see another window saying “Task not 
responding.” Click on the “End Task” button. Now run the Freeze-
Framer program.

When you’re done using the Freeze-Framer and want to connect your 
Palm Pilot to your PC, disconnect the fi nger sensor from the serial 
port, reconnect the Palm Pilot to the serial port, and restart the Hot-
Sync utility--Start Menu, Programs, Palm Desktop, HotSync Manager. 
Note: Even though the Palm is connected to the USB port instead of 
the serial port, the HotSync Manager program may still block the se-
rial port, and must be exited before the Freeze-Framer program will 
be able to fi nd the fi nger sensor attached to the serial port. 

I have a Windows CE computer that I connect to my serial port. 
Will there be a confl ict with the Freeze-Framer fi nger sensor? 

Right-click on the icon  in the system tray and uncheck the “En-
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able Serial Connection” as well as the “Enable Network Connection”

items. The icon should change to  indicating that the serial port 
is free and available for use by the Freeze-Framer fi nger sensor. No 
communication with a handheld PC via serial cable will be possible 
until the “Enable Serial Connection” is rechecked. 

The Freeze-Framer stops collecting data after about twenty 
minutes.

Go to the Edit menu, and select Options. Change Session Length 
from twenty to a higher number of minutes.

I click on the Tutorial button on the main screen and get a dialog 
box that says “Application is already running.”

Use your mouse to move to the icons at the bottom of the screen and

 click on the icon    to view the tutorial program.

I want to remove the Freeze-Framer 1.x software now that I have 
Freeze-Framer 2.0 installed.

Click on the Start icon and then select Control Panel, Add or Remove 
Programs. Select Freeze-Framer, then click on the Add/Remove 
button.  Select Freeze-Framer (not Freeze-Framer 2.0) then the 
Change/Remove icon.

I installed Freeze-Framer 2.0, but at the time, I didn’t  convert my 
user and session data from Freeze-Framer 1. How can I do that 
now?

Find where 2.0 data fi le is located by going to the Help menu, About 
Freeze-Framer, and click on the Show button. Delete the FF2.MDB 
fi le. Then start the Freeze-Framer program, and it will ask you if you 
want to transfer your old data into the new database. Note: This will 
remove current Freeze-Framer 2.0 session data.
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License, Trademark, Copyright, and Patent Notices 

The Freeze-Framer® system, including hardware, software and documentation is furnished under license and may only be used or copied 
in accordance with the terms of such license. The information in the documentation is furnished for informational use only, is subject to 
change without notice, and should not be construed as a commitment by Quantum Intech, Inc. (QI). 

Except as permitted by such license, no part of this publication may be reproduced, stored in a retrieval system, or transmitted, in any form 
or by any means, electronic, mechanical, recording, or otherwise, without the prior written permission of QI. 

Please remember that existing artwork or images may be protected under copyright law. The unauthorized incorporation of such artwork or 
images could be a violation of rights of the author(s). Please be sure to obtain any permission required from such authors. 

Freeze-Framer® is a registered trademark of QI. HeartMath® is a registered trademark of Institute of HeartMath. Quick Coherence is a 
trademark of Doc Childre. Pentium™ is a registered trademark of Intel, Inc. All other products or name brands are trademarks of their 
respective holders. 

Written and designed by Quantum Intech, Inc., 14700 West Park Avenue, Boulder Creek, CA 95006, phone: 831.338.8700; http:
//www.quantumintech.com;  info@quantumintech.com. 

For defense agencies: Restricted Rights Legend. Use, reproduction or disclosure is subject to restrictions set forth in subparagraph (c)(1)(ii) 
of the Rights in Technical Data and Computer Software clause at 252.227-7013. 

For civilian agencies: Restricted Rights Legend. Use reproduction or disclosure is subject to restrictions set forth in subparagraph (a) 
through (d) of the commercial Computer Software Restricted Rights clause at 52.227-19 and the limitations set forth in Quantum Intech’s 
standard commercial agreement for this software. Unpublished rights reserved under the copyright laws of the United States. 

FREEZE-FRAMER SOFTWARE LICENSE AGREEMENT AND WARRANTY 

YOU MAY NOT LOAD OR USE THE SOFTWARE WITHOUT THE CONSENT OF THE SOFTWARE OWNER WHO DOES NOT CONSENT 
UNLESS YOU ACCEPT THE TERMS AND CONDITIONS IN THIS AGREEMENT. BY INSTALLING OR OTHERWISE USING THE 
SOFTWARE, YOU ACCEPT ALL THE TERMS AND CONDITIONS OF THIS AGREEMENT. 

This is a legal agreement (the Agreement) between you (either an individual or an entity), the end user, and Quantum Intech, Inc. (QI). Use 
of the enclosed software including the accompanying Pulse Sensor (collectively, the SOFTWARE) indicates your acceptance of these terms 
and conditions. If you do not agree to the terms of this Agreement, promptly return the SOFTWARE package and the accompanying Pulse 
Sensor and other accompanying materials to the place you obtained them for a full refund. 

FREEZE-FRAMER SOFTWARE LICENSE AGREEMENT 

1. GRANT OF LICENSE. By this Agreement, QI grants you the following rights with respect to your use of the SOFTWARE: 

(a) License. If you are an individual, QI grants a license to you to install the SOFTWARE and use it for your personal use on any computer 
that you own or lease. In the case of a leased computer, you agree to remove the SOFTWARE from that computer should you cease 
leasing it. If you are an entity, QI grants a license to you to install the SOFTWARE on a computer at your place of business for use as a 
self-directed training program. 

This license does not allow you to use the HeartMath  brand in advertising or marketing that would imply that you are a licensed or certifi ed 
trainer of the HeartMath® system techniques nor to charge fees specifi cally for the use of the SOFTWARE by others. If you are interested in 
becoming certifi ed to use the HeartMath brand and teach HeartMath techniques in a commercial setting, using the Freeze-Framer® and/or 
to charge fees for allowing others to use the software, please contact HeartMath LLC, 14700 West Park Avenue, Boulder Creek, CA 95006; 
Phone: 831-338-8700 for information about eligibility for certifi cation. 

Authorized resellers of the SOFTWARE may use the SOFTWARE to give demonstrations of the product to multiple individuals and may 
instruct individuals on how to use the SOFTWARE, but may not charge customers for the demonstration sessions. Health Practitioners may 
use the SOFTWARE as a tool in the normal course of their delivery of health services. Hospitals, clinics, companies, schools and other 
organizations may make the SOFTWARE available on a public computer for demonstration purposes, as long as fees are not charged for 
this use.

QI does not grant you a license to use the trademarked terms Quick Coherence™, Freeze-Framer® Emotional Management Enhancer, nor 
any other trademarked terms of QI, the Institute of HeartMath or HeartMath LLC in advertising or marketing. 

(b) Transfer. You may transfer the SOFTWARE licensed under this Agreement to another computer as often as you like. If you are an 
individual, you may have the SOFTWARE installed on multiple computers simultaneously provided that all said computers are owned 
or leased by you. If you are an entity, you may have the SOFTWARE installed on a single computer only at one time for use by a single 
individual, unless you have signed a site license agreement which supercedes this agreement. You may not distribute the SOFTWARE or 
accompanying materials with other products without QI’s prior written permission. You may not rent or lease the SOFTWARE, but you may 
transfer your rights under this Agreement on a permanent basis, provided that you transfer this SOFTWARE License Card, all copies of the 
SOFTWARE and all accompanying materials and the recipient agrees to the terms of this Agreement. Any transfer of the SOFTWARE must 
include the most recent update and all prior versions of the SOFTWARE and accompanying materials. 

(c) Copying. QI grants you the right to install and use exact copies of the SOFTWARE PRODUCT on your computers. You may also make 
copies of the SOFTWARE PRODUCT as may be necessary for backup and archival purposes. 

(d) Notice to Users. You shall inform all users of the SOFTWARE of the terms and conditions of this Agreement. 

For purposes of this Agreement, use means loading the SOFTWARE into computer memory of any kind, including RAM and installation on 
a hard disk or other storage device. You may gain access to the SOFTWARE from a hard disk, over a network, or any other method you 
choose so long as you otherwise comply with this Agreement. 

2. COPYRIGHT. The SOFTWARE is owned by QI and is protected by United States copyright laws and international treaty provisions. 
Therefore, you must treat the SOFTWARE like any other copyrighted material (e.g., a book or musical recording), except that you may 
transfer and make copies of the SOFTWARE in accordance with this Agreement. (continued on inside back cover)

License, Trademark, Copyright, and Patent Notices (Continued from inside front cover)

3. PATENTS. No right or license is granted, either express or implied, under any patent wholly or partially owned licensed to or controlled by 
QI, except that a license is granted under any such patent to you to use the SOFTWARE in accordance with this Agreement. 

4. OTHER RESTRICTIONS. This SOFTWARE License is proof of your rights to use the SOFTWARE. You may not reverse engineer, 
decompile, or disassemble the SOFTWARE, except as permitted by applicable law. This Agreement is governed by the laws of the State of 
California, U.S.A., without regard to the confl icts of laws and principles thereof. 

FREEZE-FRAMER DISCLAIMER. Use Freeze-Framer and the exercises contained in the SOFTWARE as tools for individual balance, 
optimal performance and growth. Although these instruments and exercises have potentially great benefi t, no medical benefi ts or cures 
are expressed or implied. These programs and exercises are not to be used as, or used in lieu of, any course of medical or psychological 
treatment. None of the feedback or summary data provided in the software is to be interpreted as medically or psychologically diagnostic. 
Nor are the data samples themselves an objective or direct measure of any specifi c psychological, emotional or spiritual state. 

Finally, heart rate variability patterns differ widely from one person to another. There are no “right” or “wrong” patterns. The coherence 
scores in the programs and games are especially useful for comparing your own progress in increasing your ability to maintain a coherent 
state as you practice; they should not be compared between one individual and another. 

Individuals with heart irregularities such as atrial fi brillation or excessive premature ventricular contractions (PVCs) and children who are 
unable to sit still may be unable to use the Freeze-Framer successfully. 

FREEZE-FRAMER SOFTWARE LIMITED WARRANTY. QI warrants that the SOFTWARE will perform substantially in accordance with the 
accompanying printed materials for a period of ninety (90) days from the date of purchase (the Limited Warranty). Any implied warranties on 
the SOFTWARE are limited to ninety (90) days. 

SOME STATES/PROVINCES/COUNTRIES DO NOT ALLOW LIMITATIONS ON DURATION OF IMPLIED WARRANTIES, SO THE ABOVE 
LIMITATION MAY NOT APPLY TO YOU. IN THE UNITED KINGDOM: NOTHING IN THIS LIMITED WARRANTY WILL AFFECT YOUR 
STATUTORY RIGHTS, INCLUDING YOUR RIGHTS, IF ANY, AGAINST QI. 

CUSTOMER REMEDIES. QI’s entire liability and your exclusive remedy in respect of this Limited Warranty, shall be, at QI’s option, either 
(a) return of the price paid or (b) repair or replacement of the SOFTWARE that does not meet this Limited Warranty, and that is returned to 
QI with proof of purchase (i.e., a copy of your receipt). This Limited Warranty is void if failure of the SOFTWARE has resulted from accident, 
abuse, or misapplication. Any replacement SOFTWARE will be warranted for the remainder of the original warranty period or thirty (30) 
days, whichever is longer. 

IN THE U.S. & CANADA: NO OTHER WARRANTIES. To the maximum extent permitted by applicable law, QI disclaims all other warranties, 
either express or implied, including, but not limited to, implied warranties of merchantability and fi tness for a particular purpose, with respect 
to the SOFTWARE and the accompanying materials. This Limited Warranty gives you specifi c legal rights and you may also have other 
rights which may vary from state to state, province to province or country to country. 

NO LIABILITY FOR CONSEQUENTIAL DAMAGES. To the maximum extent permitted by applicable law, in no event shall QI or their 
respective suppliers be liable for any damages whatsoever, including, without limitation, damages for loss of business profi ts, business 
interruption, loss of business information or other pecuniary loss arising out of the use or inability to use the SOFTWARE, computer failure 
or malfunction, or any and all other commercial damages or losses, even if QI or any of such suppliers has been advised of the possibility of 
such damages. In such case, QI and their respective suppliers’ entire liability shall be limited to the amount paid by you for the SOFTWARE. 
Because some states/provinces/countries do not allow the exclusion or limitation of liability for consequential or incidental damages, the 
above limitation may not apply to you. 

INQUIRIES. Should you have any questions concerning this Agreement or the Limited Warranty, or if you desire to contact QI for any other 
reason, please contact our offi ce: 

Quantum Intech, Inc., 14700 West Park Avenue, Boulder, CA 95006 or call toll-free: 1-800-538-0984 © 2003 Quantum Intech, Inc. 

FREEZE-FRAMER PULSE SENSOR LIMITED WARRANTY The Basic Coverage: The pulse sensor is warranted to the owner for a 
period of ONE YEAR from the date of original purchase against defects in manufacture by QI-not by the dealer from whom the sensor 
was purchased. What QI Will Do: If this pulse sensor develops such a defect within the one year period, it will be repaired (i.e., a new or 
thoroughly reconditioned and inspected sensor will be replaced, provided it is returned with a US $5.00 check or money order to cover costs 
of postage, handling & service (this is not a repair charge), and provided you enclose proof of purchase and date of purchase. 

This Limited Warranty Does Not Cover: 

1) QI will not repair defects under the limited warranty related to servicing not performed by QI. 2) QI will not provide any warranty service 
if your pulse sensor shows evidence that it has been tampered with, misused, or altered; for example: moisture damage suffi cient to affect 
the proper function of the sensor; damage to the case; or visible damage to the wire or connector. 3) QI IS NOT LIABLE FOR INCIDENTAL, 
SPECIAL, OR CONSEQUENTIAL DAMAGES.

Some states/provinces/countries do not allow the exclusion or limitation of incidental, special, or consequential damages, so the above 
exclusion or limitation may not apply to you. Your Rights Under Implied Warranties and State/Province Law: THIS LIMITED WARRANTY IS 
IN LIEU OF ALL OTHER EXPRESS WARRANTIES, OBLIGATIONS OR LIABILITIES. QI LIMITS THE DURATION OF ANY WARRANTY 
IMPLIED BY STATE/PROVINCE LAW, INCLUDING BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND 
FITNESS FOR A PARTICULAR PURPOSE, TO ONE YEAR FROM THE DATE OF ORIGINAL PURCHASE.

Some states/provinces/countries do not allow limitations on how long implied warranties last, so the above limitation may not apply to 
you. This limited warranty gives you specifi c legal rights, and you may also have other rights which vary from state to state, province to 
province or country to country. FREEZE-FRAMER is a registered trademark of Quantum Intech, Inc. in the U.S. and other countries. © 2003 
Quantum Intech, Inc. All rights reserved. 
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Can the Freeze-Framer program run on a Macintosh? 

It’s possible using G4 or G5-based Power Mac with the Virtual PC 
program, but not recommended. For details, go to our website at 
http://www.heartmath.com/macfreezeframer.html

Why is it called Freeze-Framer? 

Doc Childre invented a tool called Freeze-Frame®, which allows you 
to stop worry or stress “in the moment.” The Freeze-Framer was 
designed to help train people to use this tool more effectively. Find 
out more about tools and techniques on our website 
http://www.heartmath.com

For more technical support visit http://support.freezeframer.com or 
call 800-538-0984 (U.S. and Canada only) or 831-338-8700, 9:30 AM 
through 4:30 PM, Monday through Friday, California time. You can 
also send an email to support@freezeframer.com, or fax your ques-
tion to 831-338-9861.

14700 West Park Avenue
 Boulder Creek, California, USA 95006 

831.338.8700 
http://www.heartmath.com 

HeartMath and Freeze-Frame are registered trademarks of 
the Institute of HeartMath.

Quick Coherence is a trademark of Doc Childre.
Freeze-Framer is a registered trademark of Quantum Intech, Inc. 
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